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Collage is a remarkable medium. Although it was a coinage from 1915-1920, from the
French colle, paste or glue, gluing together cut out pieces of illustration or colored paper has existed
for hundreds of years. Perhaps the most famous collages were those of the Cubists, who juxtaposed
real objects and clippings, etc., and the Surrealists, Max Ernst particularly, who incorporated
incongruous images. See Jonathan Talbot’s listings at www.collageart.org for lists of contemporary
collagists.
A problem that faces the collagist, is plugs. The spaces between pieces, do you fill them or
not? And if you do, with what? These processual decisions are one of the hallmarks of what most
people think of as collage.
Several things draw me to the material I use. I love the quality of engravings and lithographs
from the 19th century. Line work seems to lend itself to a much different way of working that the
half-tone images of the 20th century. The material is in the public domain, and therefore avoids the
liability of copyright infringement. For copyright purposes, collage is considered derivative, and
the new work, the collage, can be copyrighted if the artist (author) of the collage has the right to use

the original material. If the copyright has expired—leaving aside the technical questions of whether
it contained a copyright notice or whether the copyright was renewed—then there is no copyright to
violate.
In the example for this article, The Return of Arthur, I saw two images: Windsor Castle,
drawn and engraved by Stephen Miller, and Morte d’Arthur, probably drawn and engraved by
Stephen Miller, both from The Art Journal, 1869. These seemed to be interesting together. Later, I
added two mountains and a sky from Thomas Moran’s Colburn’s Butte, in Kannaro Cañon, from
The Aldine, 1874-1875.
As I was developing this article I was worried that the many examples, and many more
could have been included for instructional purposes, would be confusing or overwhelming. But
there is a way to think of all that follows so that it will make sense: This is just cut and paste collage
done digitally.
Damaged pieces must be restored. Then the images are cut out. They are placed in layers,
moved around, and they can be moved above or below other pieces.
The advantage to working digitally is that books need not be destroyed, images can be used
and reused, resized, flopped, distorted, colored, etc. The paper in some old books and magazines is
quite brittle and difficult, if not impossible to cut sometimes. Finally, your cat won’t knock the
pieces all over the floor.
For the most part I work in Photoshop, but any other good photo imaging application will
do. Occasionally, if I am going to add type, I’ll import the Photoshop image into PageMaker. I have
also incorporated Corel Painter and Illustrator files.
The Process
For line art I usually scan at around 300dpi. I do not try to pre-adjust settings to get a
“perfect” scan. See Scanning and Moiré Patterns at the end for problems and suggestions.

The beautiful Morte d’Arthur was part of a group
of loose pages in a box that was sent to me. As you can
see the right side had broken off and part was missing.
If I wanted to use the image, I felt I needed to
restore the missing corner, at least enough to have the
boat in its entirety. Usually I work from books, but to
get images and to not pay huge amounts of money, I
willingly take damaged books. Here is a place where
the decision to use the piece at all is handily resolved
by working digitally.

This is the same image scanned in two sections.
They were placed together in separate layers and nudged
together until they fit. It has been cropped, and parts of
the hull and sails were gone over with the dodging tool
to bring out the engraving lines, which were choked in
the original. The color shift is due in large part to the
size of the files and the amount of compression for this
article.

Before I start to cut out the boat, I need to remove the seam between the two pieces and I
need to restore at least the boat in the lower left corner.
I usually do this sort of work at 400-500%. I can
see the pixels but I can still discern a little of what I’m
working on. The lower arrow is pointing to the white
line of the seam between the two part of the torn image.
I do this work on a separate layer, so that I do not destroy anything, and all layers are locked. The upper arrow is pointing to what I have repaired.
I sample the existing colors and paint. I try to
vary the colors within each hue, so that the repair blends
into the whole better.

On one layer, I’ve loosely drawn in the missing
steering oar, lower white arrow, a piece of plant, upper
white arrow, and a few ripples in the water. I have also
cloned some of the water, upper black arrorw. On another layer I’ve roughly cloned in the edges of the paper, just to help frame the missing section.

I have most of the oar painted in and some of
the water. It this stage I didn’t think I need much more
of the water restored, but I wasn’t sure. The lower
arrow points to “chatter” from the cloning the water. If
I were going to keep this area, I would work on the
engraving lines and spaces to remove the chatter and
make them continuous.

I decided to quit here. I knew I could always come
back and fill in more, but I thought that this is all I would
need.

This is the entire image at the same stage as the
detail above.

The top of the masthead wasn’t in the original, on the left. On the right, I’ve drawn it in and
I am showing it against the white that I will paint in, see below.

After the repairs have been made, I started to
prepare the image to be cut out (extracted). Again on a
separate layer I painted out the sky: the black arrow
points to the paint brush cursor; for larger areas, I select
larger sections using the polygonal lasso tool and fill
that area: the white arrow points to a selected area.
I have tried other methods of extracting images,
but this is the most reliable. I paint or fill with a color
that does not exist anywhere in the image itself.

Here is the area from the previous example
painted in.

I have flattened the image into two layers, the
image and the white mask. To cut out the image:
1) With the Magic Wand select the white on the white
layer.
2) Invert the selction: Select>Inverse.
3) Make the image layer active and copy it.
4) Select File>New
5) Check the box for transparent and past the boat into
it, see below.

This is the new file with just the boat on a transparent background.

This is the raw scan of the background. I have
cropped it.

When I pasted the boat into the Windor Castle
scene, it automatically was the top layer, but if I wanted
to change that, it is easy to move layers up and down. I
have also resized the boat a little so that it doesn’t take
up the entire picture. When I nudged the boat closer to
the left edge, I became aware of several problems.

I would have seen it anyway, but the sudden
lightness of the swans pulled my eye towards them. The
white arrow points to the seam, and the problems. I could
erase the water around the boat or redraw the water lines
to make them seamless, but I would also have to deal
with drawing three oars, and the swans would continue
to be a problem, pretty though they are.

The solution I chose is outlined in white. I decided to clone and paint reeds across the foreground:
hiding the seam, some or all of the swans, and the missing oars. A darker foreground would also keep the eye
within the picture. The reeds will also create more of a
middle ground, giving more depth to the image.

This is the reed patch, made from cloning the
reeds from the corner, with some drawing, in nine separate layers.

The boat is a nice size, and it is moving in,
which pulls the eye into the picture. The viewer has a
more clearly defined position relative to the what is
happening in the picture.

I printed this file on good paper. It couldn’t be better, I said to myself. I copied the file,
flattened it, and saved it. I went to bed satisfied with the work.
In the morning, however, I found the sky simply to bland. As a narrative piece, Arthur’s
return needs something dramatic. As a composition there is nothing interesting happening in either
of the upper corners. Corners and edges are very important. Usually they need life, and two corners
and one and one-half edges are dead.
I remembered a sky from a Thomas Moran landscape.

I was only looking for a sky, but this image also has
two mountains. The sun is coming from behind the viewer’s
left shoulder in the picure above, and, fortuitously, the highlights on the mountains looks like it is reasonably consistant.
It not, I could flop the picture, or work on it with the dodging
and burning tools to adjust the highlights, but this is a good
first step, just as it is.

On a separate layer, I painted out the sky, including around the tree leaves, and amidst them where
there appeared to be the suggestion of voids. I think that
the ultimate image is more believable and marvelous if
the viewer can see between things as he would in real
life.
I used the white as a mask, selected the sky and
cut it out, moving it to another layer.

I pasted the Moran sky into the image and moved
it behind the foreground. The mountains seem fine, with
light and shadow, the sky in the middle could be
exagerated, but the upper left corner is too dark.

Here are the next three steps. First, I cut out the
Moran sky from his mountains, copying them to s separate layer. I was disturbed by the moiré patterns in the
clouds. I could rescan and play around for a day and
maybe get rid of them, or maybe not. But I knew from
previous collages that there were a few tricks I could
try. If worse came to worse, I could look for another
sky.
In the middle example, I blurred the clouds, just
to the point where the individual engraving lines disappeared.
Finally, sometimes drama helps drama: I applied
curves to the blurred clouds.

Arthur is getting the drama he deserves, but it’s
still missing. The interiour openings in the trees are like
little beacons, pulling my eye towards them, with nothing there. The upper left corner is still too dark, but I do
not want to slide the clouds up because I like how they
are positioned in the middle. And the clouds over the
face of the middle mountain are too dark and lost.

A layer over just the Moran sky and mountains, I drew and cloned a corner patch.
Not shown in these examples, I also cut a
patch of the trees and put it above the tiny holes I had
cut out.

This is the above example with the foreground
and middle ground pieces visible. The sky is very close.

A quick check at the edges showed that the blur filter has left a feathered edge, which the white
arrows point to. In a separate layer, using the cloning tool, I extended the blurred clouds to the edge
of the mountains.

Here is the final image. The sky has been toned
down a little by working with the curves; and the clouds
across the front of the mountain were worked with both
the dodging and burn tools, in highlights, middletones,
and shadows, to make them more believable.
If this was your first exposure to this kind of work, it may look daunting. With the repair, which
took a long time, it was sixty hours. Some images take less, some a lot more. With practice a simple
extraction for an average piece, like the boat or the sky takes more or less a half hour. But at its core
this is simple cut and past collage.

Three Rules, Tips and Advice
First, one of the hardest things to establish is a work flow that is consistent: you can stare
at pixels only so long before your mind turns to jelly and you realize that you’ve been at
something for an hour, but what? Was it saved? Can it be used? A consistent non-destructive
work flow allows you to survive these moments.
Second, establish your own sytem to archive your work in stages. Don’t save just the
finished piece in its flattened state, because all too often it isn’t the finished piece, and you may
have days or weeks of work ahead of you once you wake up and realize where you are. Or, perhaps
you have words you’ve typed into your work. You were mostly worried about the graphics and
design of the project, and your spelling wasn’t right. At some point you realize this and you have to
correct it. You need to be able to get back to the right state and deal with things. Archiving is like
your freezer: when you put the chili into the Ziploc bag you not only knew what it was but marveled
at the possibility that you could ever forget—no label, why? So you just pop it into the freezer.
Enough said.
If your computer doesn’t have a DVD recorder, consider it. I use up about 1 DVD for each
image, sometimes more. They are inexpensive insurance. Get a binder and print out contact sheets
of about 20 thumbnails each for your work, and keep them and the DVD, clearly labeled in a binder.
The third rule: blink periodically while you work. Your eyes will appreciate it. I keep a small
bottle of artificial tears next to my keyboard.
Layers
Work in layers. Make your adjustments, curves, hue and saturation, with adjustment layers.
These are non-destructive to what you’re adjusting.
Lock all layers against moving. When you are working you can move around the screen by
either selecting the move icon or hold the spacebar down and click and drag the piece. But, if you’re
careless, and at some point you will be, you can end up moving the layer.
When working in layers, even if you think you’re painting on layer 3, periodically check to
make sure.
I will often make what I call a comp: the merging of the layers I think are important. It gives
you a fresh place to start, especially if you’re turning layers on and off, have thirty of them, and even
your labels don’t help identify them.
Scanning and Moiré Patterns
In terms of dpi, scanning line are is relatively easy. Unlike continuous tone images where,
all things being equal, you are better with higher scanner settings, line art isn’t so fussy. That said,
a setting should be high enough keep lines smooth. I usually scan at between 240dpi and 600 dpi.
The biggest problem with scanning line art is moiré patterns (see the first of the three cloud examples
above). These are interference patterns, some are optical and some, this is my theory, are exaserbated
by software algorithms. Dan Margulis suggests in his Professional Photoshop: The Classic Guide
to Color Correction--a great book, not an easy read, but invaluable for understanding color and
working with it--that turning the piece fifteen degrees might eliminate moirés, but with clouds, for
example, that doesn’t do anything with my scanner. More effective is playing with the dpi. Changing

from a 300 dpi scan to 307 dpi, for example, might remove the moiré: you need to experiment.
Test scan and print a small piece. Sometime moirés appear on the screen and not in the print,
sometimes they aren’t there on the screen and are on the print out. Some papers make moirés more
or less prominent; some papers shift the color more or less.
Memory, Modes, and Adjustments
If you’re scanning B&W material and memory is a problem, scan in grayscale, work in
grayscale . . .you can always apply a duotone tritone or quadtone when you’re finished. These can
be converted to RGB when you’re finished.
If you’re working with color, usually scanned in RGB, do not forget that you can convert to
CMYK, or LAB, to make adjustments to the curves. Contrary to popular opinion that one should
avoid CMYK “it’s just for separation for commercial lithographic printing”: it’s not. I find that I
often have a problem adjusting the curves to effect yellow and black in RGB, and converting to
CMYK makes this easy. Then I convert back to RGB. If something is lost in those translations, it is
far less than what is gained by being able to make other changes.
If you are going to sharpen your image, do it at as the very last thing you do. In Photoshop
use the Filter>Sharpen>Unsharp Mask, you have much more control over sharpening. Save a copy
of the unsharpened image and a copy of the sharpened one.
Extracting and Mistakes
If you’ve gotten this far in the article, you have probably asked yourself: “Why doesn’t he
just use the extraction tool, it’s magic? The article would have been half as long, huh?” That’s easy,
for the kind of work I am demonstrating it doesn’t work. If you are extracting a simple outlined
image, with no breaks in the outline, it works beautifully, but all you need is a few missing pixels
and it will eat parts of your image. When I’ve used it, I will duplicate the image, go over the entire
outline, filling in every gap, then I’ll run Extract. With wood cuts and steel engravings the extract
tool has troubles when your selection doesn’t follow a line (with no gaps) and crosses lines and
spaces. It will leave very ragged edges. With ink splotches, dirt, complicated overlapping figures
you need to make the decisions, not Photoshop.
I use white because it can be distinguished from all other colors in my scans, you can use
any color that is pure and that IS NOT IN YOUR SCAN. You can change this color any time you
want by selecting it, [Magic Wand] and filling it with the color of your choice. The final selection
has a low tolerance just to make sure you don’t end up removing pixels from the original, and set it
to noncontiguous so every piece of your mask is selected.
If you paint out the backgound in a separate layer and you make a mistake, it is easy to make
corrections. You also have the history panel, where you can go back one or more steps.
I paint with a hard round brush, but not a pencil. The pencil paints a hard line that is easy to
select, invert, copy raw image, but the lines won’t be smooth. The price you pay for smooth, antialiased lines is that you will have some touch up to do along the edges later.
Tablet vs Mouse

This shouldn’t even be a question. Use a tablet. I resisted for years, when I gave in, I
bought a small 4X5 Wacom Graphire tablet. Yes, I want bigger, and the Intuos, but it is so
remarkable that I haven’t upgraded. Otherwise, this was a trick issue, use a table, not your
mouse.
If you are working with line art, wood cuts, steel engravings, you will probably want to keep
the lines sharp. If, however, you are working with halftones, you can remove the dot pattern using
the blur filter and the unsharp mask.
You can also apply filters, for example the watercolor filter, to the work, which for botanicals
is often a beautiful touch. But remember, most filters look at adjacent pixels and then make changes.
You will get different effects if you work on selections or work on the whole image. You can always
make selections and apply filters only to them. Experiment, but make always work with a copy.
Before you flatten your image, save the file with all the layers—remember you’re likely to
want to make adjustments to things tomorrow.
To Paint or Clone or Collage
Choosing which way to work usually comes up when making repairs, adding to an image,
or fitting pieces together like skies or water. The clone tool can have soft edges that leave smears
when you clone engraving lines; or hard edges that leave hard, round “footprints” when cloning
engraving lines. You can go in and draw out the smears or footprints. Some repairs or patches
can be made by adding a new piece, collage. Painting is what I use to “blend” out seams.
Printing
I assume that ultimately you’ll print your work out. Although I use an Epson 7600, I’m
surprised how good my little $90 Stylus C84 is. For finished prints, I use archival paper and Epson
Ultrachrome inks. The estimated life of around one hundred years is better than most color
photographic materials. I spray every print with three coats of an non-yellowing acrylic with UV
inhibitors: front and back. Paper absorbs moisture, polutants, etc. The better protected it is the
longer it will last.
This said, good paper is expensive, $12 - $25 per sheet. I use my cheap little C84 and Epson
Photo paper (Costco $20/100 sheets) to run quick tests. For more important tests, color or size, if I
am enlarging the image, I make test enlargements or prints. At the enlarged size, or if I’m just
checking color, I’ll select areas that concern me, and paste them into a new image, and print them
on an 8 1/2 X 11 sheet, rather than printing a full 20 X 24 inch image, only to find that I have wasted
$12 for the paper and several dollars in ink. I’ll do this to test new paper.
The curious
Whatever you do on one image might not work on the next. While I have campaigned for a
consistent work flow, you need to be flexible at the same time.

The Artist’s Golden Rule
Do no less well than you can. This also means looking at your work afresh a day to a week later. It
also means don’t assume the viewer won’t see your mistakes.
You can see more of my digital collages at www.wm-arts.com. Feel free to email me at info@wmarts.com if you have questions.

Good Reference Books
The Permanence and Care of Color Photographs, by Henry Wilhelm and contributing author
Carol Brower, www.wilhelm-research.com/book.html. This is “the world’s first—and is still the
only—book on the often controversial subject of preserving our fading color photographic heritage.”
The site, www.wilhelm-research.com, has lots of information regarding printers, inks, papers, and
other, related, subjects.
Professional Photoshop: The Classic Guide to Color Correction, by Dan Margulis, from John
Wiley & Sons, Inc., ISBN 0-471-40399-7. Do not get this book to learn Photoshop. But do get it to
understand color and learn how to make the corrections and adjustments: essential reading for
printing on inkjet printers, or preparing art for commercial printing.
Mastering Digital Printing, by Harrald Johnson, from Muska & Lipman, ISBN 1-92968-565-3.
This is a good, general book on color printing. Whether you do your own printing or have someone
do it for you, it talks about most of the things you need to know.
Making Digital Negatives for Contact Printing, by Dan Burkholder, from Bladed Iris Press,
bladediris@aol.com, ISBN 0-9649638-6-8. If you want to understand what’s going on in the digital
graphics, even if you have no desire to make your own negatives, this is the book. Titling the book
“Making Digital Negatives,” was simply a way of reducing unwanted sales, don’t let them win, buy
the book anyway.
The Photoshop 6 Wow! Book, by Linnea Dayton & Jack Davis, Peachpit Press, ISBN 0-20177208-9, www.peachpit.com. The book comes with a CD which includes tutorials, layer styles and
buttons, and lots of patterns, gradients, brushes, etc. for Photoshop. I was never able to access the
layer styles and buttons, and Peachpit never answered my email. But regardless, the book is a series
of tutorials/projects which integrate all the I’ll-never-need-that stuff with the wow-I’d-love-to-dothat stuff. (That’s not an elegant way to say it, but if you’ve worked a little with Photoshop you’ll
understand.) There is a Photoshop 7 Wow! Book edition as well.

